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1. Introduction 

1.1 About TAFPro Framework 

TAFPro is a hybrid automated testing framework that combines elements of data-driven and 
keyword-driven frameworks and adopts a role-based approach to test development and execution. 

The key objectives of an automation framework are: 

 To enable reuse and sharing of automation scripts to improve efficiency and scalability; 

 To reduce the test maintenance overhead; 

 To provide a non-technical user interface for business users; 

 To capture and leverage the domain knowledge of business users into a set of regression 
tests that can be executed repeatedly without requiring the business representative to 
be present. 

The key functions within TAFPro are: 

 Execution of tests built with Test Automation Tools such as IBM Rational Functional 
Tester, Selenium or other Java based scripting languages; 

 Easing data handling challenges for data elements used during testing; 

 The linking of tests to form scenarios and suites of associated tests. 

TAFPro has been developed with a focus on: 

 Minimizing the impact of the framework on script development; 

 Approaching test execution from a business perspective (as opposed to purely technical 
testing); 

 Providing flexibility in data association and selection. 

1.2 Intended Audience for this Guide 

The TAFPro Installation and Configuration Guide is intended for System Administrators and technical 
users who have the knowledge and system access rights to install software in their systems 
environment.  This document pre-supposes a level of knowledge in the reader to enable them to 
locate the information needed to complete the configuration of the TAFPro software to integrate 
with the test management toolset, the databases and the email servers being used in their 
implementation. 

1.3 Other TAFPro Documentation 

The TAFPro User Guide contains information for Test Analysts who will set up and use TAFPro to 
execute their testing. 

The TAFPro Scripting Guide is written to guide technical analysts who will develop scripts in one of 
the supported test scripting tools.  The Scripting Guide provides the information to enable the scripts 
to be integrated into a TAFPro environment. 

All the TAFPro documentation is included in the TAFPro distribution package and the Help section of 
TAFPro once the product is installed. 
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1.4 How to use this Manual 

This manual provides information and instructions for multiple configurations of the TAFPro 
framework, making use of a range of Databases, Test Tools and TAFPro Licence types.  The flow 
chart below indicate which sections of this document are relevant to your particular implementation 
of TAFPro. 
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2 Installation Pre-requisites 

2.1 System Requirements 

Supported Operating Systems:  

 Windows 7 – 32 and 64 bit 

 Windows 8 – 64 bit 

 Windows 10 – 64 bit 

 Windows server 2003 – 32 and 64 bit 

 Windows Server 2008 R2 – 64 bit 

RAM: 4 GB minimum 

CPU: 2.1GHz. 

Hard drive: 20GB consisting of the following: 

1. Latest version of Java Development Kit (JDK)  

2. Adobe Reader - 38MB 

3. Test Scripting Tool(s): 

3.1. IBM Rational Functional Tester (RFT) minimum Version 8.3 - 1.3GB OR 

3.2. Use Java IDEs including Eclipse, IntelliJIDEA, JDeveloper, and NetBeans to use Java based 
test scripting tools such as : 

  Selenium Web Driver for Java, OR 

  AutoIT 

4. Database – one of: 

4.1. MySQL Server minimum Version 5.5.33 - 31.2 MB 

 MySQL Workbench 5.2.44 - 26.3 MB 

4.2. SQL Server minimum 2008 R2 

5. TestPro Automation Framework Version - 25MB 

6. Additional suggested storage to allow for database growth and for data, results and test script 
storage will depend on how many tests are run in TAFPro.  Suggested 20GB, but should be 
monitored as TAFPro is used and increased if necessary. 
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2.2 Software Requirements 

The following applications must be available on the system where TAFPro is to be installed.  

1. MS Excel – to build datasheets for TAFPro. 

2. Java Development Kit. 

2.1. Required for the underlying technology on which TAFPro is built and will run Command 
Line Interface capabilities. 

3. Test Scripting Tool: required for the underlying Scripting tool on which TAFPro tests are 
built. 

 IBM Rational functional Tester (refer IBM installation guide), OR 

 Java IDEs including Eclipse, IntelliJIDEA, JDeveloper, and NetBeans (refer installation 
guide of each corresponding IDE), to use test scripting tools such as Selenium and AutoIT. 

4. Database. 

4.1. Required for the underlying database containing TAFPro data and Configuration 
settings. 

 MySQL-essentials and MySQL tools from http://dev.MySQL.com/downloads/  
Note: TAFPro Trial and Full license can connect to mySQL . 

 SQL Server from http://www.microsoft.com  
Note: Only TAFPro Full license can be connected to SQL Server database. 

5. Adobe Reader from http://get.adobe.com/reader/otherversions/ - required to view all 
printed matter for TAFPro, the User Manual, End User Licence Agreement, Installation Guide 
and Release Notes. 

6. TAFPro Solution – application for managing test execution and data. 

 

 

http://dev.mysql.com/downloads/
http://www.microsoft.com/
http://get.adobe.com/reader/otherversions/
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3 Install Required Software 

3.1 Install Java Development Kit 

Java Development Kit is required when installing TAFPro and when executing tests in TAFPro.    
Note: 32 bit machines need 32 bit java installed.  64 bit machines need 64 bit java installed.  

For 32 and 64 bit installations: 

1. Using Windows Explorer go to C:\Program Files\Java (64bit) or C:\Program Files(x86)\Java 
(32bit). If there is already a JDK Directory, go to the next section. Do not install again;  

2. If installing for the first time, download the JDK from www.oracle.com\java.  The 
recommended version is JDK 8 or higher; 

3. Click on the downloaded jdk-xuxx-windows-i586 (32 bit Java) and jdk-xuxx-windows-x64 (64 
bit Java) to install; 

4. Follow the instructions on the screen to complete the installation; 

5. Accept default settings and click Next to install; 

6. When installation has finished click Finish to complete. 

After Java installation is complete, navigate to Path System variable under (Control Panel  System 
 Advanced System Settings  Environment Variables  System variables  Path), and ensure 
your Java bin directory is added to “Path” system variable. 

3.2 Install Adobe Reader 

Adobe Reader is used to display the following documents: 

 Various licenses of the Open Source components used within TAFPro 

 TAFPro User Guide 

 TAFPro Installation Guide 

 RFT Scripting Guide 

 Java Scripting Guide 

 End User License Agreement 

To download and install Adobe Reader access the following web site: 
http://get.adobe.com/reader/otherversions/ 

To install the software: 

1. Check if the PC being installed has Adobe installed and move to next section if Adobe is 
already available.  

2. From the above listed website Select the Operating system and Language according to 
where TAFPro will be installed. 

3. Click Continue. 

http://www.oracle.com/java
http://get.adobe.com/reader/otherversions/
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4. Download by clicking the Download Now button and save the file to your hard disk.  

5. Double-click the AdbeRdrxxx_en_US.exe on your hard disk to start the Setup program.  

6. Follow the instructions on the screen to complete the installation.  

7. If connected to the Internet, Adobe may search for and install any updates. 

3.3 Install Test Scripting Tool 

TAFPro 5.2 supports execution of test scripts written with IBM Rational Functional Tester or other 
Java based test scripts written with either Selenium Web Driver or AutoIT.  Users can also use 
several different Java IDEs including Eclipse, IntelliJIDEA, JDeveloper and NetBeans to develop Java 
based scripts for execution with TAFPro.  

Depending on the selected test scripting tool, please refer to their affiliated installation 
documentation provided with the download. E.g refer to the IBM Installation Guide provided with 
IBM software in order to install Rational Functional Tester. 

Note: To configure an IBM Rational Functional Tester project with TAFPro, please refer to TAFPro 
RFT Scripting Guide.  

To configure a Java IDE project with TAFPro, please refer to TAFPro Java Scripting Guide. Both of 
these documents are provided in the download package. 

3.4 Install TAFPro Database 

TAFPro currently executes with SQL Server and MySQL databases.  The Trial TAFPro software will 
only install and configure a MySQL database. Depending on the database to be used, go to the 
relevant sections 5 and 6 for database server installation and database creation.  Your organisation’s 
internal company procedures should be adhered to when creating the TAFPro Database.  

This section only applies to database installations. For upgrade of existing databases refer to the 
TAFPro Upgrade Guide and bypass this section.  

3.4.1 Install MySQL 

The TAFPro installation assumes that the user performing the installation not only has the authority 
to install the DBMS, but also access to the DBA authority to create the database, load the tables and 
define the user authorities to the database. 

To download and install MySQL access the following web site: http://dev.MySQL.com/downloads/ 

From the website: 

1. Select MySQL Community Server from List in the Left Column. 

2. Select the Platform to suit your Operating System (Microsoft Windows). 

3. Save the MSI File to your local disk. 

4. Double-click the MySQL Server executable file on your hard disk to start the Setup program.  

http://dev.mysql.com/downloads/
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5. Continue clicking Next as the installation wizard starts. 

6. If prompted to check for latest updates, click on the Execute button to continue installation. 

7. When prompted select the default selection in the Setup Type window. 

8. Continue clicking Next until prompted to install. 

9. Click Execute to begin the installation. If prompted, uncheck the “Register the MySQL 
Server now” option. 

10. Click Next through the Configuration Overview section. 

11. Enter a password for the database root account, usually defaulting to root. 

12. Accept default settings by clicking Next. 

13. Click Finish to complete the installation. 

If using MySQL Server version 5.5.33, you will be required to install MySQL Workbench.  Newer 
versions of MySQL Server are packaged to include MySQL Tools.  Access the following web site: 
http://dev.MySQL.com/downloads/to download and install MySQL Tools separately. 

From the website: 

1. Select MySQL Workbench & Utilities (GUI Tool) from List in the Left Column. 

2. Select Archives on the Downloads tab. 

3. Select MySQL Workbench. 

4. Select the Platform to suit your Operating System (Microsoft Windows). 

5. Download Microsoft Windows 32 (Windows Installer Format). 

6. Save the MSI File to your local disk. 

7. Double-click the MySQL-workbench- gpl-5.2.44-win32.msi program file on your hard disk 
to start the Setup program.  

8. Follow the setup wizard clicking Next prompts until the setup completes. Accept all the 
program defaults. 

9. Click Install to begin the installation. 

10. Click Finish to complete MySQL Workbench installation. 

11. Note the username and password for MySQL Workbench. This information will be required 
later while creating the TAFPro MySQL database. 

After MySQL and Workbench installation is complete, navigate to Path System variable under 
(Control Panel  System  Advanced System Settings  Environment Variables  System 
variables  Path), and ensure your MySQL server bin directory is added to “Path” system variable. 

http://dev.mysql.com/downloads/
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3.4.2 Install SQL Server 

Please refer to the SQL Server Installation Guide to install SQL Server.  

You can find the details of TAFPro SQL server database creation in section 5.2 of this document. 
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4 Install TAFPro Framework 

4.1 TAFPro Trial Installation Package 

1. Extract the zip file downloaded. 

2. Open Windows Explorer.  

3. The following files will be displayed: 

 setup.exe – the installation executable 

 TAFPro Installation Guide (this document)  

 TAFPro RFT Project Setup Guide 

 TAFPro Java Scripter Guide 

 TAFPro User Guide 

 TAFPro Upgrade Guide v5.2.0 

 Release Notes 

 Readme file 

Where an earlier version of TAFPro is installed on a PC, refer to the TAFPro Upgrade Guide for 
TAFPro v5.2.0 to update the existing database and application.  

4.1.1 Install from setup file 

1. Double-click the setup.exe program file in your TAFPro Installation package to start the TAFPro 
Setup. 

2. The TAFPro splash screen will display, followed by the Installation Welcome screen. 

3. Follow the setup wizard by clicking Next prompt to display Licence Agreement. 

4. Read Licence Terms and click I Agree to accept the terms of the licence agreement. 

5. On Install Location screen, select a Destination folder in which to install TAFPro. 

5.1. The default path is C:\Program Files directory, but can be changed to another location. 

6. Click the Next button. 

7. Choose Additional Locations screen will display showing the default paths for the TAFPro project 
(DataStore) and log directories. 

7.1. The default is C:\Users\Public\TestPro\TestPro Automation Framework, however this can 
be changed depending on which TAFPro environment type is being installed. Please review 
table below for further details.  

7.2. DataStore Path holds all the TAFPro enabled files which enable RFT or other Java IDE 
projects to work with TAFPro. The following table shows the DataStore path for RFT and 
different Java IDEs. The installation can proceed with the default paths initially and this can 
be changed later, when the user is logging in to TAFPro for the first time. 
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 TAFPro Environment Data Store path 

RFT <\Project> 

Eclipse <\Project>\bin 

IntelliJ IDEA <\Project>\out\production 

JDeveloper <\Project>\classes 

NetBeans <\Project>\build\classes 

Table 1 - TAFPro DataStore Path Setup 

7.3. Log Path holds all the TAF logs when running TAFPro. 

8. Once the paths are set, click the Next button. 

9. Click Install on the Start Menu Folder window. Wait while TAFPro completes installation. 

10. TAFPro Trial Setup Wizard will create the “tafdb” database as part of the installation. In order to 
complete the creation of the “tafdb” database, when prompted with the following screen, enter 
the MySQL password that was created in Step 11 of Section 3.4.1 of this document to setup 
MySQL Server Workbench.  

Note: TAFPro Trial will only connect to a MySQL database. 
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Figure 1 - TAFPro Trial DB connection setup 

11. Click on Next button once password has been entered.  

12. Upon successful database connection, the following window will be displayed. 

 

Figure 2 - TAFPro Trial user details 

13. Make a note of the Username and Password. These credentials are needed to access TAFPro 
application. 

14. Click on OK button. Then, click on OK button in the following pop-up. 
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Figure 3 - Database setup completed successfully 

15. On the TAFPRO Installation Complete screen, , tick the check box if you have an existing RFT 
project ready to use with TAFPro, then click on Next button.   
If you have an existing Java project that you wish to configure for use with TAFPro, click on Next 
button without ticking the check box to complete the installation. Once installation has been 
completed, review the Java Scripting Guide for detailed steps on configuring your existing Java 
project.  

16. If existing RFT project check box is selected, then you will be prompted to connect to your RFT 
project. Once prompted with the following screen, navigate to your RFT project root node, then 
click on OK. 

 

Figure 4 - RFT Project Setup 

17. Click on OK on the following window to finish TAFPro RFT project setup. 
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Figure 5 - RFT Remote Project completed 

18. If RFT project check box is NOT selected, then you will navigate to Generate License screen. 

19. On Generate License screen, click on Generate button to generate your machine ID. 

 

Figure 6 - Generate Machine ID 
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20. Copy the machine ID and click on Finish button to navigate to TAFPro website to generate your 
30 days Trial License using the machine ID. 

21. Click Finish at the Completing TestPro Automation Framework Setup Wizard window. 

22. TAFPro Trial installation is now complete. Upon successful TAFPro installation, TestPro 
Automation Framework will appear in your Start Menu and a shortcut will be created on your 
desktop. 

4.2 TAFPro Full License Installation Package 

1. Extract the zip file downloaded. 

2. Open Windows Explorer. 

3. The following files will be displayed: 

 setup.exe – the installation executable 

 Create_MySql_tafdb52.zip 

 Create_SqlServer_tafdb52.zip 

 TAFPro Installation Guide (this document)  

 TAFPro RFT Project Setup Guide 

 TAFPro Java Scripter Guide 

 TAFPro User Guide 

 TAFPro Upgrade Guide v5.2.0 

 Release Notes 

 Readme file 

Where an earlier version of TAFPro is installed on a PC, refer to the TAFPro Upgrade Guide to 
update the existing database and application.  

4.2.1 Install from setup file 

1. TAFPro Full license installation is similar to TAFPro Trial installation. To install TAFPro Full 
license follow steps 1-9 in section 5.1.1 of this document.  

2. TAFPro Full license can be connected to a MySQL database or a SQLServer database. Once 
MySQL server or SQL server is installed, follow the steps in section 5.1 and 5.2 to create 
TAFPro databases for TAFPro full license. 

3. Once the TAFPro database is created, you need to enter the TAFPro database connection 
parameters in the following window: 
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Figure 7 - TAFPro Full Version DB Connection Setup 

4. Click on Next. 

5. If the Schema field is left blank, an information dialogue will appear informing you that the 
Schema will be set to the database name.  

6. Click OK. 

7. A screen with Driver and Dialect dropdowns will be displayed. 

8. Select the driver name from the drop down list. The settings provided are the defaults. 

Database Driver Dialect 

MySQL com.MySQL.jdbc.Driver MySQLInnoDialect 

SQL Server com.microsoft.sqlserver.jdbc.SQLServerDriver SQLServerDialect 

Table 2 - TAFPro DB Driver Options 

9. Click Continue. 

10. A Popup will be displayed to create super_admin user. 
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Figure 8 - super_admin user setup 

11. Create the Administration User in TAFPro to enable the initial login and creation of other 
users and environments in TAFPro.  

 Enter a user name (the default is super_admin). 

 Enter a password for the super_admin user (The password must be at least 6 characters 
long). 

 Confirm entered password. 

 Click Create to create the super_admin user. 

12. Click OK to confirm creation. 

 

Figure 9 - super_admin created successfully 

13. Click Next to continue. 

14. Similar to TAFPro Trial installation, if you have an existing RFT project; tick the check box to 
configure your RFT project with TAFPro. If you have an existing Java Project or your RFT 
project is not ready, click on Next to continue with TAFPro installation.  

15. On Generate License screen, click on Generate button to generate your machine ID. 

16. Copy the machine ID and click on Finish button to navigate to TAFPro website to generate 
your 1 year TAFPro full License. 

17. By generating the machine ID, the TAFPro Full License installation is completed. Upon 
successful TAFPro installation, TestPro Automation Framework will appear in your Start 
Menu and a TAFPro shortcut will be created on your desktop. 
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18. Click Finish to complete the installation. 
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5 Create Database for TAFPro Full Licensed Version 

5.1 MySQL Database Setup for TAFPro Full License 

TAFPro MySQL DDL is located in the TAFPro installation zip file.  

To create TAFPro database, please follow the instructions below carefully: 

1. Start MySQL Workbench: Start  Programs  MySQL  MySQL Workbench 

2. A new database connection needs to be established.  

2.1. Open Database  Connect to Database window. 

2.2. Accept default parameters for hostname and port. 

2.3. Login as the root database account (password created during installation process), click 
OK. 

2.4. Click on the Create a new schema icon in the Object Browser panel. 

2.5. Enter “tafdb” as the Database Name in the new schema window. 

2.6. Click Apply to create the TAFPro database. 

2.7. Click Apply again from the resultant pop up window. 

2.8. Click Finish to close the new Schema window. 

2.9. Close New Schema window when completed. 

3. Set schema created in 2.4 above to default schema.  

3.1. Select tafdb under Schemas in the Object Browser panel. 

3.2. Right click and select Set as Default Schema. Once set as default schema, the name 
should be highlighted in bold. 

4. Click File  Open SQL script. 

5. Click on the tafdb_52_create_MySql SQL file in TAFPro installation Zip folder. 
Could this be written as – Navigate to the TAFPro installation Zip folder and click on the 
tafdb_52_create_MySql file.? 

6. Click Open to display the script in the window editor. 

7. Click Execute (lightning bolt icon will only take seconds to complete). 

8. Click Refresh icon in Schemas section of left menu to display the table list in the database. 

9. Close MySQL Workbench, database setup is complete. 

10. When the database is setup the following details need to be provided to the person 
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installing TAFPro: 

 Database name. 

 Schema Name (will be same as database name for MySQL). 

 Port. 

 Instance (Not Required for MySQL). 

 TAFPro Database user name and password - the username should have Select, Insert, 
Update and Delete access to the TAFPro Database. 

5.2 Create SQL Server Database for TAFPro Full License 

Note: SQL Server Database is only available for TAFPro Full License. 

TAFPro assumes that SQL Server is already installed and that an SQL Server DBA will create the 
database, load the tables and set initial authorities.  

The DDL to perform these tasks can be found on the installation Zip folder. These SQL scripts need to 
be applied in the following order:  

1. tafdbdb.sql – to define the TAFPro database. 

2. tafdb_tables_52.sql – to define the database username, tables, indexes and foreign keys. 

3. tafdb_authorities_52.sql – to grant authorities on the tables to the database username. 

4. tafdb_inserts_52.sql – to load the tables with initial required data. 

5. When the database is setup the following details need to be provided to the person 
installing TAFPro: 

 Database name. 

 Schema Name. 

 Port. 

 Instance. 

 TAFPro Database user name and password - the username should have Select, Insert, 
Update and Delete access to the TAFPro Database. 
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6 Configure TAFPro Database Connection 

This section only applies to users installing the Full licensed version of TAFPro. The Trial version sets 
up a MySQL database by default as part of the installation. 

Where possible, the user should allow the TAFPro installation wizard to assist with the database 
setup and configuration, however if for some reason the setup wizard was not used to configure the 
database or the database was changed, please follow the steps below carefully to configure the 
database.  

1. Click Start → Programs → TestPro Automation Framework  

2. The following program entries will be displayed. 

 

Figure 10 - Start  All Program  Testpro Automation Framework menu 

3. Click Configuration. A process similar to the installation will commence. 

4. Select the Installer Language then click OK. 

5. The TAFPro start screen will display, followed by the Installation Welcome screen. 

6. Follow the setup wizard clicking Next. 

7. The Database Connection Parameters Screen is displayed to configure the connection to the 
TAFPro Database. The following entries should be made: 

 Type: Select the database type from the drop-down selection list. 

 User: Enter the Database Login and Password that will be used to connect to the 
Database. 

 Connection Parameters: Enter the details to establish a connection to the TAFPro 
Database. 

 Server: the name of the server on which the database resides; defaults to “localhost” for 
installations on the local PC. 

 Instance: this value is only required for SQL Server databases and only if the DBA has 
created a database instance. For MySQL, this value will be blank. 

 Port: the port number of the database (default ports are: MySQL 3306, SQL Server 1433). 
Please enter the port number advised by your DBA. 
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 Schema: For MySQL the schema name should be left blank as it defaults to the database 
name. For SQL Server, the TAFPro database user name is the default. Any other value will 
be provided by the DBA. 

 Database: Defaults to tafdb for all database types. Any other value will be provided by 
the DBA. 

8. Click Next. If the Schema field is left blank, an information dialogue will appear informing 
you that the Schema will be set to the database name. 

9. Click OK. 

10. A screen with Driver and Dialect dropdowns will be displayed. 

11. Select the driver name from the drop down list. The settings provided are the defaults. 

Database Driver Dialect 

MySQL com.MySQL.jdbc.Driver MySQLInnoDialect 

SQL Server com.microsoft.sqlserver.jdbc.SQLServerDriver SQLServerDialect 

Table 3 - TAFPro DB Driver Options 

12. Click Continue. 

13. A Popup will be displayed to create super_admin user. 

14. Create the Administration User in TAFPro to enable the initial login and creation of other 
users and environments in TAFPro.  

15. Accept the user name as super_admin. 

16. Enter a password for the super_admin user (the password must be at least 6 characters 
long). 

17. Re-confirm entered password. 

18. Click Create to create the super_admin user. 

19. Click OK to confirm creation. 

20. Click Next to continue. 

21. Click Finish to complete the installation. 
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7 Setup TAFPro for first-time login 

After successful TAFPro installation, please follow the steps below for initial TAFPro login. 

1. From the desktop, right click on TestPro Automation Framework, and select ‘Run as 
administrator’. 

2. When prompted by Select TAFPro License File window, navigate to directory where you have 
saved the TAFPro license and click on Open. The TAFPro license was generated as part of the 
Installation process from the TAFPro website https://www.testingautomationframework.com/ 
and would have been emailed to your registered email address. 

 

Figure 11 - TAFPro license lookup 

3. Enter the super_admin username and password created previously.  

3.1. For TAFPro Trial: Enter the user credentials that were displayed after successful database 
creation (step 13 of section 4.1.1 above). 

3.2. For TAFPro Full: Enter super_admin username and your preferred password that was setup 
after successful database creation. 

4. Select the Environment (the super_admin user only uses the Default Environment). 

4.1. TAFPro can be configured to execute an RFT project or Java projects created in other 
popular Java IDEs. To manage the different project types, TAFPro environments are divided 
into RFT Environment and Java Environment. 

4.2. TAFPro Trial has only two environments: Local_RFT for RFT projects and Local_JAVA for Java 
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projects. 

4.3. TAFPro Full version allows users to create any number of RFT or Java environments. Select 
Default environment when signing-in for the first time as super_admin user.  

5. Click on Details button to set the Paths for TAFPro.  

5.1. DATASTORE: This is where TAFPro finds the TAFPro Project. Depending on the scripting tool, 
this path should be directed to the specific project directory where the scripts are located. 
For TAFPro installations on multiple PC’s this may be a centrally located remote repository. 
E.g. C:\Users\Public\TestPro\TestPro Automation Framework or \\[shared drive]\TAFPro 
Enabled Projects\projectname. 

5.2. OUTPUTPATH: This is the default location that will be accessed to find or create files hen 
the export or import options for data groups is used in TAFPro.. Default is to set this to the 
user’s local directory or if files need to be accessed by many machines a central shared 
drive that all users can access. E.g. C:\Users\Public\TestPro\TestPro Automation 
Framework\Output Files or \\[shared drive]\TAFPro Enabled Projects\projectname\Output 
Files\[Username]. 

5.3. LOG PATH: All TAFPro Logs and execution logs will be added to this directory. This should 
be a local path on the PC that all users can access, or alternatively on a Shared Drive but a 
different directory for each TAFPro User E.g. C:\Users\Public\TestPro\TestPro Automation 
Framework\Logs or \\[shared drive]\TAFPro Enabled Projects\projectname\Logs\[User-
name]. 

5.4. TEST PROGRAM:  

 RFT Usage: This is where Rational Functional Tester is installed and where eclipse.exe is 
located. E.g. C:\Program Files\IBM\SDP\eclipse.exe. 

 Java Usage: This is not used for Java projects, therefore it can be left blank or set to C:\. 

6. After successful login, TAFPro Main Window will display as follows: 
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Figure 12 - TAFPro Main Window 

7. Set the Java Path. 

7.1. Go to User  Preferences. 

7.2. Select Java from the Menu Tree. 

7.3. Set Java Program.  

7.3.1. If using Rational Functional Tester, the Java Program will need to be set to the JRE in 
the Rational Functional Tester Installation Path. E.g. C:\Program 
Files\IBM\SDP\jdk\jre\BIN\JAVA.exe 

7.3.2. If using Selenium or other third-party Java libraries, the Java Program will need to be 
set to the version of JRE or JDK installed on the machine. 

8. Set the Build Path. 

8.1. This section only needs to be setup if third-party libraries such as Selenium libraries are 
used. 

8.2. Go to User  Preferences. 

8.3. Select Build Path from the Menu Tree 

8.4. Right click on User Libraries pane and select New. 

8.5. Navigate to where the third-party libraries such as Selenium libraries are located and add 
them here. 
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8 Connect TAFPro to a Rational Functional Tester Project 

When using Rational Functional Tester (RFT) for the first time, the user will need to setup and 
configure TAFPro to see the RFT project and access the scripts within it. If the user has an existing 
RFT project during TAFPro installation, then select “yes, I have an existing RFT project” option and 
provide the project location at that time. Otherwise, follow the steps below to setup and configure 
RFT for first time use. 

RFT projects should be copied to a separate directory before being connected to TAFPro because 
TAFPro modifies the contents and structure of the Project. For example, if the RFT project is stored 
as X:\RFTProjects\ClassicsCD you could copy it to X:\TAFProjects\ClassicsCD. Both the project 
directory and the project logs directory should be copied. Do not copy the RFT workspace across.  

Users require the same access rights in the TAFProjects directory as in the RFTProjects directory.  

NB: The instructions in this section should be implemented for each RFT project that will be 
executed.  Configure TAFPro to existing RFT project repository. 

Copy the RFT project to the TAFPro Project directory. Your TAFPro Project directory should be similar 
to this: 

 

Figure 13 - e.g. of TAFPro project directory 

Within the TAFPro Project the RFT project directory should be similar to this:  
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Figure 14 - TAFPro RFT project directory 

 

8.1 Configure the TAFPro connection to Remote Repository 

Follow the steps below if you have not competed RFT Remote configuration as part of TAFPro 
installation setup wizard. 

1. Start the Remote Repository Process, Start  All Program  TestPro Automation 
Framework  RFT Project Setup  

2. Choose the Installer Language and Click OK 

3. The TAFPro start screen will display, followed by the Installation wizard Welcome 
screen 

4. Follow the setup wizard clicking Next 

5. A Browse For Folder window appears for the Remote RFT Repository 

6. Navigate to your Remote Project and select its top level folder and click OK. 

7. The ‘Remote Repository Setup is Complete’ dialogue appears. 

8. Click OK 

9. Click Finish at the Completing the TestPro Automation Framework Setup Wizard 
screen  

10. Configuration of the Remote Repository is now complete.  

11. The TAF Project directory should be unchanged 
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12. The RFT project directory in TAF should now contain additional data. 

 

Figure 15 - RFT project directory after RFT remote 

13. Upgrade the RFT project to include the TAFPro setup   Start RFT 

14. Click File  Connect to a Functional Test Project 

15. Navigate to the copy of Functional Tester project in the TAFPro projects folder.  Click 
Finish to load the RFT project into the workspace. 

8.2 Add TAFPro jars to the Build Path 

NB: If you are upgrading your installation you should ensure you follow the upgrade instructions 
supplied which differ from these instructions 

1. In RFT right click on project name  Select  Properties  Select Java Build Path  
Select Libraries tab 

2. Click Add Library to create a user library for TAFPro jars 

3. Select User Library then Next. 
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4. In the Add Library window click User Libraries 

5. Select New, enter the User Library name as TAFPro and click OK  

6. Add external jars from the TAFPro installation directory lib folder to the TAFPro user 
library, click OK, then Finish, then OK to close the properties window. 
(%installation_Directory%\TestPro\TestPro Automation Framework\lib) 

7. Reset the Java Path by right clicking on the RFT project folder name and selecting 
Reset Java Build Path if necessary  

8. Do a Clean and build from the Project menu in RFT 

9. Check that no new problems have been added to your project.  

8.3 Install the TAFPro ScriptSuperClass 

1. To change the Script Helper SuperClass right click [project name]  Properties 

2. Select Functional Test Project from left pane of the new window 

3. Click on the Script Helper Super class Browse button 

4. Find “ScriptSuperClass” by entering the keyword in the Select default helper 
superclass for new scripts prompt. 

5. Select “ScriptSuperClass” to highlight the Superclass option that appears 

6. Click OK on the screen 

7. Click Apply on the Properties for {project} Window. 

8. Perform a Clean and Build from the Project menu. 

9. Check that no new problems have been added to your project 

8.4 Update Pre-existing Scripts 

Pre-existing scripts need to have their superclass altered manually.  If this is not done during this 
process, it will show up as error(s) when the script or project is converted for use with TAFPro.  

1. To change the Script Helper SuperClass right click [script]  Properties 

2. Select Functional Test Script  from left pane of the new window 

3. Click on the Script Helper Super class Browse button 

4. Find “ScriptSuperClass” by entering the keyword in the Select default helper 
superclass for new scripts prompt. 

5. Select “ScriptSuperClass” to highlight the Superclass option that appears 

6. Click OK on the screen 
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7. Click Apply on the Properties for {script} window. 

8. Perform a Clean and Build from the Project menu. 

8.5 Best Practice 

1. Create a separate folder directly under the Project for TAFPro enabled scripts.  Place 
converted scripts back into this folder as part of the conversion process  

2. Create a folder for scripts converted to work with TAFPro under the project name. 
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9 Connect TAFPro to a Java Project 

Please refer to TAFPro Java Scripting Guide for detailed instructions on how to configure TAFPro 
with popular Java IDEs including Eclipse, IntelliJ IDEA, NetBeans, and JDeveloper.  The TAFPro Java 
Scripting Guide is included in the documents folder of the TAFPro installation files. 
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10 Configure TAFPro for Rational Quality Manager 

Two files, TAFRQMAdapterClient.zip and TAFRQMUpdateSite.zip will be supplied with the 
installation media. There are 3 parts to setting up TAFPro integration with Rational Quality Manager.  

10.1 Setup Rational Quality Manager Connector User 

 Go to Rational Quality Manager to set up the Rational Quality Manager Connector User.  

 The Quality Manager Administrator should create a User ID for the Rational Quality Manager 
User and assign a Connector Client Access Licence to that ID. 

 The user type is Jazz User.  

 For instructions on how to create users in Rational Quality Manager please refer Rational 
Quality Manager User Documentation.  

 Add this user as a member to the Project Area. E.g. TAFPro INTEGRATION. 

10.2 Deploy TAFPro Client Plug-in 

1. Copy TAFRQMUpdateSite.zip to the Rational Quality Manager server.  

2. Unzip TAFRQMUpdateSite.zip to a location in Rational Quality Manager server. This location 
has to be out of the Rational Quality Manager installation path. For instance, unzip it to 
C:\Users\Public\TestPro in a Windows 2008 server. 

3. Folder C:\Users\Public\TestPro\Update\au.com.testpro.taf.adapter.site and file 
com.testpro.taf.adapter.web.profile.ini will be created after the unzip function is complete.  

4. Right click on the com.testpro.taf.adapter.web.profile.ini and open with Word Pad.  

5. Update the URL = line to reflect the location of your update site. E.g. 
url=file:C:\\Users\\Public\\TestPro\\Update\\au.com.testpro.taf.adapter.site 

6. Save and close the file com.testpro.taf.adapter.web.profile.ini 

7. Copy com.testpro.taf.adapter.web.profile.ini from C:\Users\Public\Testpro to 
Jazz_Server_Install_Path\server\conf\qm\provision_profiles 

8. Refresh the Eclipse plug-in configuration through Quality Manager Web UI. 

https://<server>:9443/qm/admin?internal#action=com.ibm.team.repository.admin.serverR
eset 

9. Restart Jazz Server to pick up the plug-in. 

10.3 Setup TAFPro Client 

1. Unzip TAFRQMAdapterClient.zip. Use a location on your local PC. E.g. C:\...\All 
Users\TestPro. To keep the adapter installation files together you can add a directory here 
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called TAFRQMAdapterClient. Unzip to this location. This path may change depending on the 
operating system used. This may be C:\Users\Public\TestPro for Win7 or C:\Documents and 
Settings\All Users\TestPro for XP 

2. Go to DOS prompt and navigate to the path where your TAFPro RQM Adapter is unzipped to, 
e.g. C:\Users\Public\TestPro\TAFRQMadapterClient 

3. Run the Start.bat located here.  

3.1. The User will be prompted for the following information:  

 username and password as created in Section Error! Reference source not found. above 

 The Rational Quality Manager Repository URL. e.g. 
https://vhost1234.dc1.sg.ap.compote.ahost.com:9443/qm.  This information may need 
to be requested from your Rational Quality Manager Administrator. 

 Project Area. E.g. “TAFPro INTEGRATION (Quality Management)”.  This information may 
need to be requested from your Rational Quality Manager Administrator.  

3.2. If the connection details entered in step 3.1 above are correct, the adapter will connect 
to the RQM Server and config.ini will be created to hold these details. When running 
start.bat with the present config.ini, the adapter will be using the connection details in 
this file to connect to RQM server. User can modify the connection details either by 
editing the config.ini file or removing config.ini then run start.bat to enter the details 
when prompted.  

3.3. If the connection details are incorrect, the adapter cannot connect to the RQM server. 
An error will be prompted in the DOS prompt session. Config.ini will not be created.  

 

 

 

https://vhost1234.dc1.sg.ap.compote.ahost.com:9443/qm
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11 Setup SMTP Service 

TAFPro provides the user an ability to email test results for any given test execution to a specific user 
or group of users. This functionality is only available in the full licensed version of TAFPro.  

To enable the SMTP service, a generic TAFPro test email address should be set up on your mail 
server. This account is only used to validate the SMTP service and send results from TAFPro. 
Individual email addresses for receiving TAFPro emails can later be added to tailor messages without 
the need to save email passwords. This service needs to be setup only once for a TAF database 
instance.  

1. Launch TAFPro by double clicking on TAFPro on the desktop 

2. Login as super-admin account in Default environment 

3. Select User  Administration  SMTP Service setup 

4. Provide relevant information for the following fields:  
Server: this is the SMTP Server for outgoing email (ask your network administrator for this 
information as well as the Port number below) 
Port: SMTP port number 
Address: enter the generic email address to be used to email results from TAFPro 
Password: the password for above email address 

5. Apply to save the change 

6. Click Defaults to clear the settings. 

11.1 Email Setup at Environment Level 

1. Right Click on the Environment Name. 

2. Select Email Setup. 

3. Enter default email addresses and the default Sender Full Name for this environment.  

These values are used throughout the environment unless overwritten in a user environment or 
when the user is executing a task requiring an email address.  
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12  Reset TAFPro License from Trial to Full 

In the event that you want to replace a TAFPro Trial licence with a TAFPro Full licence; click User  
Administration  Reset TAFPro Licenses. 

 

Figure 16 - Reset TAFPro License 

Once the Reset TAFPro License option has been selected, TAFPro must be relaunched and run as 
administrator. Then, navigate to the directory location where the full license file is located and select 
it.  
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13 Uninstall TAFPro Suite 

When the uninstall option is chosen, the process will remove the TestPro Automation Framework 
application. It will not remove the complete directory structures if Functional Tester scripts reside 
under this TAFPro directory.  

To remove the TAFPro application: 

 From the desktop, Click Start  TestPro Automation Framework  Uninstall TestPro 
Automation Framework 

 Select the Installer Language then click OK 

 Click the Next button 

 Select Uninstall at the TestPro Automation Framework Uninstall window.  

 A new window will display when the uninstall is complete.  

 Select Close and restart the machine to complete the uninstall 

On Windows 10 machines, TAFPro can be removed through the Control Panel  Add or Remove 
Programs option. 
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14 Appendix A – Solutions to Common Problems 

Troubleshooting 

 

 

 

 

 

 

 

ERROR: Server Configuration Wizard issues Error 1045 during MySQL Apply security settings step.  

SOLUTION: 

Start the MySQL command line client. Simply press ENTER when asked for a password. 

Change the password by running the following line. 

SET PASSWORD FOR 'root'@'localhost' = PASSWORD ('root'); 

ERROR: I do not see TAFPro’s five windows.  

SOLUTION: 

At TestPro Automation Framework choose Window>Show all 


